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Autocad	3d	modelling.

Introduction	to	AutoCAD	3D	Commands	AutoCAD	is	three-dimensional	CAD	software	that	is	used	commercially	across	the	world.	Developed	by	Autodesk	in	the	year	1982.	AutoCAD	is	also	available	as	a	mobile	and	web	app,	which	is	marketed	as	AutoCAD	360.	AutoCAD	offers	an	exclusive	range	of	commands	and	functions	both	for	3D	and	2D	modeling
and	drawing	with	an	amazing	set	of	tools.	3D	is	all	about	the	third	Z	coordinate.	While	working	in	2D,	the	user	only	cares	for	the	X	and	Y	axis,	and	most	of	the	time,	coordinates	are	not	used.	Whereas,	while	working	with	3D,	the	user	uses	all	the	coordinates,	which	can	even	make	their	work	quite	easier.	Why	do	I	need	a	3D?	Today,	technology	has
made	it	possible	to	link	our	imagination	a	bit	closer	to	the	reality,	and	it	can	be	done	by	3D	modeling,	printing,	rendering	and	more.	A	huge	number	of	software	is	available	in	the	market	that	offers	the	users	to	bring	their	imagination	into	reality.	Some	of	the	software	is	freeware,	while	some	are	priced.	With	every	update	and	with	continuous	new
discoveries,	people	are	more	attracted	to	the	technology	offering	them	to	make	and	create	vivid	designs.	The	need	for	3D	is	a	necessary	part	of	the	designing	world.	Without	it,	the	design	almost	looks	like	a	sketch.	Moreover,	3D	is	a	boost	for	all	the	interior	designers,	architects	who	can	design	life-like	models	of	any	building,	office	or	any	exterior
with	some	interiors	as	well	like	furniture,	walls,	show	pieces	and	more.	3D	modeling	The	process	of	creating	a	mathematical	representation	of	any	surface	of	an	object	in	three	dimensions	by	using	special	software	is	called	3D	modeling.	A	3D	model	can	even	be	represented	as	a	two-dimensional	image	by	using	the	3D	rendering	process.	The	user	can
also	create	3D	models	physically	using	3D	printers.	There	is	a	lot	of	software	that	is	used	to	create	3D	models	like	AutoCAD,	MAX,	MAYA,	and	many	more.	3D	models	are	high	in	demand	with	the	game	developers	as	well.	Some	computer	games	use	already	rendered	images	of	3D	models,	which	are	known	as	sprites.	This	helps	the	designer	to	view	the
model	in	all	directions,	and	they	can	make	sure	that	the	object	created	is	like	the	original	one.	Presently,	3D	models	are	also	used	by	the	movie	industry;	they	use	them	as	objects	for	animated	and	real-life	pictures.	Also,	since	a	lot	of	VFX	is	used	in	movies	and	the	gaming	industry,	3D	models,	renders	and	effects	are	most	commonly	used.	The	medical
industry	also	uses	3D	models	of	organs.	Some	of	the	benefits	of	3D	modeling	are:	–	Using	3D	models,	users	can	get	a	more	evocative	design,	and	they	can	even	see	the	virtual	images	of	their	projects.	An	architectural	3D	model	is	much	more	interesting	and	realistic	than	a	2D	model.	The	experience	that	a	3D	model	gives	is	much	more	compelling	and
satisfying	to	the	user	than	viewing	a	2D	drawing.	The	user	can	see	the	impact	of	all	the	minor	and	major	changes	made	in	a	3D	model.	This	also	aids	in	the	better	finishing	of	the	designs	without	wasting	time	and	money.	3D	models	are	an	amazing	advantage	to	interior	designers	as	they	get	to	create	and	then	modify	3D	interior	as	well	as	exterior	as
per	their	need	and	choice.	In	a	3D	design,	the	user	gets	to	know	the	physical	dimensions	of	the	objects	and	their	distance	in	relation	to	other	objects	in	the	total	layout.	This	feature	helps	enormously	to	see	and	modify	arrangements	of	objects	based	on	their	sizes.	Some	artists	use	a	mixture	of	3D	modeling	for	best	results	by	editing	the	2D	computer-
rendered	images	from	the	3D	model.	Top	AutoCAD	3D	Commands	Let	us	look	at	the	top	commands,	which	are	as	follows:	Revolve	Location:	Draw	>	Modeling	>	Revolve	This	AutoCAD	3D	command	creates	a	3D	solid	by	revolving	a	2D	object	around	an	axis.	Extrude	Location:	Draw	>	Modeling	>	Extrude	This	AutoCAD	3D	Extrude	command	allows	the
user	to	create	a	3D	object	by	extruding	a	2D	face	along	a	line	or	path.	For	example,	A	cylinder	can	be	created	by	selecting	a	2D	circle	and	extruding	it	along	with	a	path.	Sweep	Location:	Draw	>	Modeling	>	Sweep	This	command	helps	the	user	to	extrude	the	2D	objects	without	the	2D	face	being	orthogonal	to	the	beginning	of	the	path.	Union
Location:	Modify	>	Solids	Editing	>	Union	This	AutoCAD	3D	command	allows	the	user	to	combine	two	objects	converting	them	into	one	single	object.	Subtract	Location:	Modify	>	Solids	Editing	>	Subtract	This	command	is	opposite	to	the	union	command;	this	command	works	when	there	is	a	common	area	in	both	the	objects.	Then	this	command
subtracts	the	object	A	from	the	object	B.	Intersect	Location:	Modify	>	Solid	Editing	>	Intersect	With	this	AutoCAD	3D	command,	the	user	is	left	with	the	area	that	is	common	to	both	the	objects.	3D	Drawing	Tools	AutoCAD	is	primarily	used	for	generating	2D	sketches.	While	it	is	possible	to	create	3D	objects,	AutoCAD	is	built	around	a	flat,	sketch-
based	interface.	There	is	a	wide	range	of	pre-defined	3D	objects	in	AutoCAD.	These	objects	are	cylinders,	spheres	and	wedges	and	many	more.	But	then	users	use	2D	objects	and	modify	them	using	the	3D	commands	accordingly.	So,	AutoCAD	3D	commands	like	Extrude,	Sweep,	Revolve,	Union	are	used	by	the	users.	Also,	the	user	must	know	the
importance	of	the	Viewport	feature	if	they	are	working	on	3D	Models.	The	viewport	command	allows	the	user	to	split	the	drawing	area	into	different	windows	to	project	multiple	views	of	the	model.	These	include	the	top,	front,	left/right	views	of	the	object.	This	feature	works	great	for	the	user	and	helps	them	to	observe	the	model	from	different
aspects.	Conclusion	–	AutoCAD	3D	Commands	AutoCAD	3D	Commands	is	a	lengthy	and	challenging	software	for	the	beginners.	Yet	it	is	extremely	useful	and	has	a	lot	of	benefits.	It	is	a	powerful	CAD	software,	which	is	used	for	architectural	design	and	mechanical	engineering.	It	has	one	of	the	best	toolboxes	and	functions	to	support	2D	drawings.
However,	it	is	impressive	when	it	comes	to	3D	design,	with	its	3D	rendering	feature	that	gives	stunning	and	vivid	outputs.	Recommended	Articles	This	has	been	a	guide	to	AutoCAD	3D	Commands.	Here	we	have	discussed	different	AutoCAD	3D	commands	like	Extrude,	Sweep,	Revolve,	Union,	Subtract,	Intersect.	You	may	also	look	at	the	following
article	to	learn	more	–	AutoCAD	Commands	Uses	Of	AutoCAD	3D	Software	Design	AutoCAD	For	Students	Full	PDF	PackageDownload	Full	PDF	PackageThis	PaperA	short	summary	of	this	paper13	Full	PDFs	related	to	this	paperDownloadPDF	Pack	1.	AutoCAD	3D	Tutorials	-	1	-	AutoCAD®	2013	3D	Tutorials	By	Kristen	S.	Kurland	C	o	p	y	r	i	g	h	t	©	2	0
1	2	AutoCAD	is	a	registered	trademark	of	Autodesk,	Inc.	2.	AutoCAD	3D	Tutorials	-	2	-	AutoCAD	3D	–	Chapter	1	3D	Interface	3.	AutoCAD	3D	Tutorials	-	3	-	1.1	Launch	AutoCAD	1.	Choose	Start,	Programs,	Autodesk	,	AutoCAD	from	the	Windows	program	manager.	OR	2.	Double-click	the	AutoCAD	icon	from	your	desktop.	Workspaces	AutoCAD
workspaces	are	sets	of	menus,	toolbars	and	dockable	windows	(such	as	the	Properties	palette,	DesignCenter,	and	the	Tool	palettes	window)	that	are	grouped	and	organized	so	that	you	can	work	in	a	custom,	task-oriented	drawing	environment.	1.	Click	the	Workspace	Switching	icon.	2.	Click	3D	Basics	and	OK.	4.	AutoCAD	3D	Tutorials	-	4	-	1.2	3D
Basics	Interface	The	following	is	AutoCAD’s	3D	Basic	interface.	The	3D	Basic	ribbons	are	as	follows:		Create		Edit		Draw		Modify		Selection		Coordinates		Layers	and	Views	The	3D	Basic	pulldown	menus	are	as	follows:		Home		Render		Insert		Manage		Output		Plug-ins		Online		Express	Tools	5.	AutoCAD	3D	Tutorials	-	5	-	1.3	3D	Modeling	Interface	The
3D	Modeling	panels	are	as	follows:		Modeling		Mesh		Solid	Editing		Draw		Modify		Section		Coordinates		View		Selection		Layers	and	Groups	The	3D	Modeling	pulldown	menus	are	as	follows:		Home		Solid		Surfaces		Mesh		Render		Parametric		Insert,	Annotate,	View,	Manage,	Output,	Plug-ins,	Online,	and	Express	Tools	6.	AutoCAD	3D	Tutorials	-	6	-	1.4
Viewports	1.	Open	a	drawing	or	create	simple	objects	as	shown	below.	2.	Click	the	dropdown	menu	in	the	shortcut	tools	and	choose	Show	Menu	Bar.	3.	Choose	View,	Viewports,	4	Viewports.	OR	4.	Type	-VPORTS	at	the	command	prompt.	Command:	-VPORTS	Enteranoption	[Save/Restore/Delete/Join/SIngle/?/2/3/4]	4:	enter	Enteraconfiguration
option[Horizontal/Vertical/Above/	Below/Left/Right]	:	enter	Your	screen	will	look	something	like	the	figure	below	with	four	views	in	one	AutoCAD	drawing.	7.	AutoCAD	3D	Tutorials	-	7	-	1.5	Preset	3D	Viewports	1.	Choose	View,	Viewports,	New	Viewports	2.	Click	the	dropdown	option	for	Setup	and	click	3D.	3.	Choose	Four:	Right	as	the	viewport	option.
8.	AutoCAD	3D	Tutorials	-	8	-	1.6	Named	Views	1.	Choose	View,	Named	Views…	2.	Click	the	plus	(+)	sign	beside	Preset	Views.	3.	Click	NE	Isometric,	Set	Current,	Apply,and	OK.	Tip:	You	can	also	choose	View,	3D	Views,	and	any	of	the	preset	3D	views.	9.	AutoCAD	3D	Tutorials	-	9	-	1.7	Steering	Wheel	SteeringWheels	are	menus	that	track	the	cursor
over	the	drawing	window,	and	provide	access	to	2D	and	3D	navigation	tools	from	a	single	interface.	SteeringWheels,	or	“wheels,”	are	divided	into	wedges;	each	wedge	contains	a	single	navigation	tool.	You	can	start	a	navigation	tool	by	clicking	a	wedge	or	by	clicking	and	dragging	the	cursor	over	a	wedge.	Full	Navigation	Wheel	1.	Click	the	Full
Navigation	Wheel	icon.	10.	AutoCAD	3D	Tutorials	-	10	-	2D	Navigation	Wheel	(Zoom/Pan)	View	Object	Wheel	–	Center	a	model	and	define	the	pivot	point	to	use	with	the	Orbit	tool.	Zoom	and	orbit	a	model.	Center	11.	AutoCAD	3D	Tutorials	-	11	-	Orbit	Look	12.	AutoCAD	3D	Tutorials	-	12	-	Walk/Up/	Down	Rewind	Shortcuts	1.	Right-click	on	the	wheel	to
view	shortcuts.	13.	AutoCAD	3D	Tutorials	-	13	-	Steering	Wheel	Settings	1.	Right-click	on	the	steering	wheel	and	choose	SteeringWheel	Settings…	14.	AutoCAD	3D	Tutorials	-	14	-	1.8	VPOINT	Command	(Tripod)	Displays	a	compass	and	tripod	for	defining	a	view	rotation.	The	compass	represents	a	two	dimensional	globe.	1.	Choose	View,	3D	Views,
Viewpoint	or	2.	Type	VPOINT	at	the	command	prompt.	Command:	VPOINT	Rotate/:	PRESS	ENTER	3.	Click	a	point	on	the	compass	to	define	the	viewing	angle.	Point	in	the	center	of	the	compass	is	the	“	north	pole”,	looking	straight	down	at	the	drawing	Middle	ring	of	the	compass	is	the	“equator”,	looking	straight	on	at	the	drawing.	Entire	outer	ring
isthe	“south	pole”,	looking	straight	up	at	the	drawing.	Tripod	15.	AutoCAD	3D	Tutorials	-	15	-	1.9	VPOINT	Command	(Rotate)	Enters	a	rotation	angle	at	the	viewpoint	prompt.	1.	Type	VPOINT	at	the	command	prompt.	Command:	VPOINT	Rotate/	:	R	(enter)	Enter	angle	in	XY	plane	from	X	axis	:	225	(enter)	Enter	angle	from	XY	plane	:	15	(enter)	16.
AutoCAD	3D	Tutorials	-	16	-	1.10	DDVPOINT	1.	Choose	View,	3D	Views,	Viewpoint	Preset.	or	2.	Type	DDVPOINT	at	the	command	prompt.	Command:	DDVPOINT	3.	Set	a	viewing	angle	by	typing	the	From	X	axis	and	XY	Plane	angle.	or	4.	Pick	a	viewing	angle	in	the	2	graphics	Left	graphic	=	From	X	Axis	Right	graphic	=	In	XY	Plane	5.	Click	OK.	17.



AutoCAD	3D	Tutorials	-	17	-	1.11	Plan	View	1.	Choose	View,	3D	Views,	Plan	View	,	World	UCS.	or	2.	Type	PLAN	at	the	command	prompt.	Command:	PLAN	Enter	an	option	[Current	Ucs/Ucs/World]	:	World	18.	AutoCAD	3D	Tutorials	-	18	-	AutoCAD	3D	–	Chapter	2	Thickness	and	Elevation	19.	AutoCAD	3D	Tutorials	-	19	-	2.1	Thickness	Command	1.
Begin	a	new	drawing	using	a	3D	Modeling	workspace.	2.	Choose	View,	Viewports,	2	Viewports.	3.	Press	ENTER	for	the	default	of	two	vertical	viewports.	4.	Type	PLAN	and	World	in	the	left	viewport.	5.	Choose	SE	Isometric	for	the	right	viewport.	6.	Type	THICKNESS	at	the	command	prompt.	Command:	THICKNESS	Enter	new	value	for	THICKNESS	:
3	7.	Draw	a	5”,2”	rectangle	using	in	the	LINE	command	in	the	left	view.	The	lines	will	have	a	3D	“thickness”	that	can	be	seen	in	the	3D	view.	20.	AutoCAD	3D	Tutorials	-	20	-	2.2	Change	Existing	Thickness	1.	Select	the	object	whose	thickness	you	would	like	to	change	(e.g.	one	line	of	the	rectangle	you	drew	in	2.1.	2.	Choose	Modify,	Properties…or
right	click	and	choose	Properties…	3.	Type	a	new	line	thickness.	The	result	is	a	new	line	thickness	for	the	selected	object.	21.	AutoCAD	3D	Tutorials	-	21	-	2.3	Elevation	Stores	the	elevation	for	new	objects	relative	to	the	current	UCS	for	the	current	space.	1.	Type	ELEVATION	at	the	command	prompt.	Command:	ELEVATION	Enter	new	value	for
ELEVATION	:	1.00	2.	Draw	two	circles	in	the	left	view	at	the	new	elevation.	Note	that	they	appear	to	be	“floating”	1	unit	above	the	ground.	22.	AutoCAD	3D	Tutorials	-	22	-	2.4	Elevation	Shortcut	1.	Type	ELEV	at	the	command	prompt.	Command:	ELEV	Specify	new	default	elevation:	:	2	Specify	new	default	thickness:	:	.5	2.	Draw	a	new	line	in	the	left
view	to	see	the	elevation	and	thickness	settings.	23.	AutoCAD	3D	Tutorials	-	23	-	AutoCAD	3D	–	Chapter	3	Visualizing	Your	Model	24.	AutoCAD	3D	Tutorials	-	24	-	3.1	HIDE	Command	Regenerates	a	three-dimensional	model	with	hidden	lines	1.	Open	a	drawing	with	3D	objects	and	display	in	a	3D	view.	2.	Choose	View,	Hide.	or	3.	Type	HIDE	at	the
command	prompt.	Command:	HIDE	25.	AutoCAD	3D	Tutorials	-	25	-	3.2	Visual	Styles	A	visual	style	is	a	collection	of	settings	that	control	the	display	of	edges	and	shading	in	the	viewport.	Open	a	drawing	with	3D	objects	and	display	in	a	3D	view.	Choose	View,	Visual	Styles	and	one	of	the	following	style	options.	26.	AutoCAD	3D	Tutorials	-	26	-	Visual
Styles	2D	Wireframe	3D	Wireframe	3D	Hidden	Realistic	Shaded	Shaded	with	Edges	Shades	of	Gray	Sketchy	XRay	27.	AutoCAD	3D	Tutorials	-	27	-	3.3	Visual	Style	Manager	The	Visual	Styles	Manager	displays	sample	images	of	the	visual	styles	available	in	the	drawing.	The	selected	visual	style	is	indicated	by	a	yellow	border,	and	its	settings	are
displayed	in	the	panel	below	the	sample	images.	1.	Choose	View,	Visual	Styles,	Visual	Styles	Manager…	or	2.	Type	VISUALSTYLES	at	the	command	prompt.	Command:	VISUALSTYLES	3.	Choose	the	desired	option	from	one	of	those	available	in	the	drawing	for	2D	Wireframe,	3D	Wireframe,	3D	Hidden,	Realistic,	or	Conceptual	options.	28.	AutoCAD	3D
Tutorials	-	28	-	3.4	Visual	Styles	Panel	29.	AutoCAD	3D	Tutorials	-	29	-	3.5	Adaptive	3D	Grid	When	you	choose	a	shaded	or	3D	wireframe	visual	style,	the	grid	changes	from	a	dotted	grid	to	a	rectangular	grid.	The	new	grid	provides	a	better	sense	of	a	model’s	orientation	in	3D.	The	rectangular	grid	supports	perspective,	can	display	major	and	minor
grid	lines,	provides	color	options,	and	can	automatically	control	the	grid	density	when	zooming	in	or	out	(adaptive	grid.)	You	can	change	the	grid	settings	using	the	drafting	settings	dialog	box.	1.	Choose	Tools,	Drafting	Settings,	and	the	Snap	and	Grid	TAB.	2.	Type	DSETTINGS	at	the	command	prompt.	Command:	DSETTINGS	TIP:	You	can	turn	the
adaptive	grid	on/off	from	the	status	bar.	30.	AutoCAD	3D	Tutorials	-	30	-	AutoCAD	3D	–	Chapter	4	Z	Coordinates	31.	AutoCAD	3D	Tutorials	-	31	-	4.1	3D	Coordinates	Entering	3D	Cartesian	coordinates	(X,Y,Z)	is	similar	to	entering	2D	coordinates	(X,Y).	In	addition	to	specifying	X	and	Y	values,	you	specify	a	Z	value.	1.	Open	a	drawing	with	3D	objects
and	display	in	a	3D	view.	2.	Type	3DPoly	at	the	command	prompt.	Command:	3DPOLY	Specify	start	point	of	polyline:	1,1,0	Specify	endpoint	of	line	or	[Undo]:	1,2,1	Specify	endpoint	of	line	or	[Undo]:	2,2,1	Specify	endpoint	of	line	or	[Close/Undo]:	2,1,0	Specify	endpoint	of	line	or	[Close/Undo]:	1,1,0	The	result	will	be	the	following	lines	that	are	drawn
in	3D:	32.	AutoCAD	3D	Tutorials	-	32	-	4.2	Track	in	Z	Direction	With	AutoTrack	(polar	tracking	and	object	snap	tracking),	you	can	track	in	the	Z	direction	as	well	as	in	the	XY	plane.	Similarly,	when	Ortho	mode	is	turned	on,	you	can	lock	the	cursor	to	the	Z	direction.	1.	Press	F11	or	click	OSnap	Tracking	on	the	status	bar	if	it	is	not	already	on.	2.	Press
F10	or	click	Polar	Tracking	on	the	status	bar	if	it	is	not	already	on.	3.	Draw	a	line	in	the	3D	view	in	the	Z	direction	using	tracking.	33.	AutoCAD	3D	Tutorials	-	33	-	4.3	Move	in	Z	Direction	1.	Open	a	drawing	with	3D	objects	in	it.	2.	Type	MOVE	at	the	command	prompt.	Command:	move	Select	objects:	pick	object	in	3D	view	Select	objects:	press	enter
Specify	base	point	or	displacement:	Specify	second	point	of	displacement	or	:	0,0,1	or	use	polar	tracking	to	move	the	object.	before	move	after	move	34.	AutoCAD	3D	Tutorials	-	34	-	4.4	3D	Point	Filters	Draws	in	3D	Z	direction	by	filtering	X	and	Y	coordinates.	1.	Open	a	drawing	with	3D	objects	in	it.	Use	the	CIRCLE	command	and	place	it	using	3D
point	filters	(.xy)	Command:	CIRCLE	Specify	center	point	for	circle	or	[3P/2P/Ttr	(tan	tan	radius)]:	.XY	of	pick	endpoint	to	filter	(need	Z):	1	Specify	radius	of	circle	or	[Diameter]	:	press	enter	endpoint	to	filter	35.	AutoCAD	3D	Tutorials	-	35	-	4.5	Helix	Creates	a	2D	or	3D	spiral.	1.	Begin	a	new	drawing.	2.	Choose	Draw,	Helix.	or	3.	Type	HELIX	at	the
command	prompt.	Command:	helix	Number	of	turns	=	3.0000	Twist=CCW	Specify	center	point	of	base:	pick	point	Specify	base	radius	or	[Diameter]	:	enter	or	drag	and	pick	Specify	top	radius	or	[Diameter]	:	enter	or	drag	and	pick	Specify	helix	height	or	[Axis	endpoint/Turns/turn	Height/tWist]	:	enter	or	drag	and	pick	36.	AutoCAD	3D	Tutorials	-	36	-
AutoCAD	3D	–	Chapter	5	User	Coordinate	System	37.	AutoCAD	3D	Tutorials	-	37	-	5.1	UCS	Icon	The	UCS	icon	represents	the	orientation	of	the	user	coordinate	system	(UCS)	axes	and	the	location	of	the	current	UCS	origin.	It	also	represents	the	current	viewing	direction	relative	to	the	XY	plane.	AutoCAD	displays	the	UCS	icon	differently	for	2D,	3D
and	Paper	Space	environments.	1.	Choose	View,	Display,	UCS	Icon.	or	2.	Type	UCSICON	at	the	command	prompt.	Command:	ucsicon	Enter	an	option	[ON/OFF/All/Noorigin/ORigin/Properties]	:	ON	Displays	the	UCS	icon.	OFF	Turns	off	the	display	of	the	UCSICON.	All	Affects	the	display	of	the	UCSICON	in	all	viewports.	Noorigin	Always	displays	the
UCS	at	the	lower	left	corner.	Origin	Shows	the	UCS	at	the	0,0,0	origin	of	the	current	UCS.	Properties	Changes	the	display	properties	of	the	UCS	icons(s).	3D	UCS	icons	2D	UCSIcon	Pspace	UCSICON	38.	AutoCAD	3D	Tutorials	-	38	-	UCS	Icon	Properties	1.	Choose	View,	Display,	UCS	Icon,	Properties.	or	1.	Type	UCSICON	at	the	command	prompt.
Command:	ucsicon	Enter	an	option	[ON/OFF/All/Noorigin/ORigin/Properties]	:	P	39.	AutoCAD	3D	Tutorials	-	39	-	5.2	UCS	Overview	The	user	coordinate	system	provides	an	alternate	movable	coordinate	system	for	coordinate	entry,	planes	of	operation,	and	viewing.	Most	AutoCAD	geometric	editing	commands	are	dependent	on	the	location	and
orientation	of	the	UCS.	There	are	a	variety	of	ways	to	set	the	User	Coordinate	System	using	the	UCS	command.	1.	Type	UCS	at	the	command	prompt.	Command:	UCS	Specify	origin	of	UCS	or	[Face/NAmed/OBject/Previous/View/World/X/Y/Z/	ZAxis]	:	Face	Aligns	the	UCS	to	the	selected	face	of	a	solid	object.	Named	Saves	or	restores	a	UCS.	Object
Lets	you	define	a	new	UCS	by	pointing	at	an	object.	Previous	Restores	the	previos	UCS.	New	Defines	a	new	coordinate	system	by	one	of	six	methods:	Origin,	Z	Axis,	3	Point,	Object,	Face,	View	X,	Y,	Z	View	Establishes	a	new	UCS	whose	XY	plane	is	perpendicular	to	your	viewing	direction	(e.g.	parallel	to	your	screen).	World	Restores	the	world	UCS
X/Y/Z	Rotates	the	ucs	around	a	specified	axis	UCS	Toolbars	Found	under	the	AutoCAD	Classic	Toolbars	40.	AutoCAD	3D	Tutorials	-	40	-	5.3	New	(3	Point)	UCS	The	3	Point	option	is	one	of	the	easiest	ways	to	define	a	new	UCS	on	a	given	3D	object.	1.	Open	a	drawing	with	a	simple	3D	object	(e.g.	3D	box)	2.	Type	UCS	at	the	command	prompt.
Command:	UCS	Specify	origin	of	UCS	or	[Face/NAmed/OBject/Previous/View/World/X/Y	/Z	/ZAxis]	:N	Specify	origin	of	new	UCS	or	[ZAxis/3point/OBject/	Face/View/X/Y/Z]	:	3	Specify	new	origin	point	:	pick	origin	Specify	point	on	positive	portion	of	X-axis	:	pick	point	for	X	direction	Specify	point	on	positive-Y	portion	of	the	UCS	XY	plane	:	pick	point	for
Y	direction	Positive	Y	New	0,0,0	origin	Positive	X	41.	AutoCAD	3D	Tutorials	-	41	-	New	UCS	TIP:	You	can	also	click	the	dropdown	beside	WCS	and	click	New	UCS.	42.	AutoCAD	3D	Tutorials	-	42	-	5.4	Plan	UCS	To	work	in	the	plan	view	of	your	new	UCS,	use	the	PLAN	command	with	the	current	UCS	option.	New	entities	that	you	draw	will	be	in	relation
to	this	current	UCS.	1.	Type	PLAN	at	the	command	prompt.	Command:	PLAN	Enter	an	option	[Current	ucs/Ucs/World]	:	PRESS	ENTER	43.	AutoCAD	3D	Tutorials	-	43	-	5.5	World	UCS	The	World	UCS	is	the	only	UCS	guaranteed	to	be	the	same	in	all	AutoCAD	drawings	and	can	be	used	to	set	the	UCS	back	to	its	original	state.	This	is	the	UCS	you
should	use	when	creating	Wblocks	and	inserting	Wblocks.	1.	Type	UCS	at	the	command	prompt.	Command:	UCS	Specify	origin	of	UCS	or	[Face/NAmed/OBject/Previous/View/World/X/Y	/Z	/ZAxis]	:W	44.	AutoCAD	3D	Tutorials	-	44	-	5.6	View	UCS	Establishes	a	new	coordinate	system	whose	XY	plane	is	perpendicular	to	your	viewing	direction	(i.e.
parallel	to	your	screen)	1.	Type	UCS	at	the	command	prompt.	Command:	UCS	Specify	origin	of	UCS	or	[Face/NAmed/OBject/Previous/View/World/X/Y	/Z/ZAxis]	:V	45.	AutoCAD	3D	Tutorials	-	45	-	5.7	Dynamic	UCS	You	can	use	the	dynamic	UCS	to	create	objects	on	a	planar	face	of	a	3D	solid	without	manually	changing	the	UCS	orientation.	During	a
command,	the	dynamic	UCS	temporarily	aligns	the	XY	plane	of	the	UCS	with	a	planar	face	of	a	3D	solid	when	you	move	the	cursor	over	the	face.	When	the	dynamic	UCS	is	active,	specified	points,	and	drawing	tools,	such	as	polar	tracking	and	the	grid,	are	all	relative	to	the	temporary	UCS	established	by	the	dynamic	UCS.	1.	1.	Click	the	DUCS	icon	on
the	status	bar	or	2.	Press	CTRL	+D.	3.	Type	any	draw	command.	Command:	CIRCLE	4.	Move	the	cursor	to	the	face	of	the	3D	object	on	which	you	Would	like	to	draw.	5.	Click	to	begin	drawing	your	new	object.	46.	AutoCAD	3D	Tutorials	-	46	-	5.8	Naming	a	UCS	User	coordinate	systems	can	sometimes	be	complicated	and	it	is	often	useful	to	name	and
save	them	so	you	can	quickly	recall	them.	1.	Type	UCS	at	the	command	prompt.	Command:	UCS	Specify	origin	of	UCS	or	[Face/NAmed/OBject/Previous/View/World/X/Y/Z	/ZAxis]	NA	Enter	an	option	[Restore/Save/Delete/?]:	S	Enter	name	to	save	current	UCS	or	[?]:	LeftSide	47.	AutoCAD	3D	Tutorials	-	47	-	5.9	Restoring	a	UCS	A	named	and	saved	UCS
can	be	restored	at	any	time.	1.	Type	UCS	at	the	command	prompt.	Command:	UCS	Specify	origin	of	UCS	or	[Face/NAmed/OBject/Previous/View/World/X/Y/Z	/ZAxis]	NA	Enter	an	option	[Restore/Save/Delete/?]:	R	Enter	name	to	save	current	UCS	or	[?]:	LeftSide	48.	AutoCAD	3D	Tutorials	-	48	-	5.10	UCS	Dialog	Box	Displays	and	modifies	defined	and
unnamed	user	coordinate	systems,	restores	named	and	orthographic	UCSs,	and	specifies	UCS	icon	and	UCS	settings	for	viewports	via	a	dialog	box.	1.	Chose	Tools,	Named	UCS.	or	2.	Type	UCSMAN	at	the	command	prompt.	Command:	UCSMAN	49.	AutoCAD	3D	Tutorials	-	49	-	5.10	Viewcube	The	ViewCube	provides	visual	feedback	about	the	current
orientation	of	a	model.	The	ViewCube	can	help	you	adjust	the	viewpoint	of	a	model.	The	orientation	shown	by	the	ViewCube	is	based	on	the	North	direction	of	the	WCS	for	the	model.	The	ViewCube	also	shows	the	current	UCS	and	allows	you	to	restore	a	named	UCS.	50.	AutoCAD	3D	Tutorials	-	50	-	AutoCAD	3D	–	Chapter	6	3D	Orbit	51.	AutoCAD	3D
Tutorials	-	51	-	6.1	Constrained	3D	Orbit	3DORBIT	activates	a	3D	Orbit	view	in	the	current	viewport.	You	can	view	your	entire	drawing	or	select	one	or	more	objects	before	starting	the	command.	When	3DORBIT	is	active,	the	target	of	the	view	stays	stationary	and	the	camera	location,	or	point	of	view,	moves	around	the	target.	However,	from	the
user's	point	of	view,	it	appears	as	if	the	3D	model	is	turning	as	the	mouse	cursor	is	dragged.	In	this	way,	you	can	specify	any	view	of	the	model.	1.	Open	a	drawing	with	3D	objects.	2.	Choose	View,	Orbit,	Constrained	Orbit.	or	3.	Type	3D	Orbit	at	the	command	prompt.	Command:	3DOrbit	4.	Click	and	drag	to	move	your	object	in	3D.	52.	AutoCAD	3D
Tutorials	-	52	-	6.2	Zoom	and	Pan	in	3D	Orbit	Zoom	1.	Click	the	right	mouse	button	while	in	the	3D	Orbit	command.	2.	Choose	Zoom	Window	from	the	pop-up	menu.	3.	Zoom	to	a	new	area	of	the	3D	drawing.	4.	Click	the	right	mouse	button	while	in	the	3D	Orbit	command.	5.	Choose	Zoom	Previous	or	Zoom	Extents.	Pan	1.	Click	the	right	mouse	button
while	in	the	3D	Orbit	command.	2.	Choose	Other	Navigation	Modes	from	the	pop-up	menu.	3.	Choose	Pan.	4.	Pan	to	a	new	area	of	the	drawing.	5.	Click	the	right	mouse	button	while	in	the	3D	Orbit	command.	6.	Choose	Other	Navigation	Modes	from	the	pop-up	menu.	7.	Choose	Constrained	Orbit	to	set	the	mode	back	to	orbit.	53.	AutoCAD	3D	Tutorials
-	53	-	6.3	Projection	Mode	1.	Click	the	right	mouse	button	while	in	the	3D	Orbit	command.	2.	Choose	Perspective.	Perspective	view	displays	objects	in	perspective	so	that	all	parallel	lines	converge	at	one	point.	Objects	appear	to	recede	into	the	distance,	and	parts	of	the	objects	appear	larger	and	closer	to	you.	The	shapes	are	somewhat	distorted	when
the	object	is	very	close.	This	view	correlates	more	closely	to	what	your	eye	sees.	Parallel	view	displays	objects	so	that	two	parallel	lines	in	a	drawing	never	con	verge	at	a	single	point.	The	shapes	in	your	drawing	always	remain	the	same	and	do	not	appear	distorted	when	they	are	closer.	Perspective	View	Parallel	View	54.	AutoCAD	3D	Tutorials	-	54	-
6.4	Visual	Styles	Displays	your	objects	in	one	of	the	following	selected	styles:	1.	Click	the	right	mouse	button	while	in	the	3D	Orbit	command.	2.	Choose	Visual	Styles	from	the	pop-up	menu.	3.	Choose	one	of	the	Visual	Styles.	Visual	Style	Examples	3D	Hidden	3D	Wireframe	Conceptual	Realistic	55.	AutoCAD	3D	Tutorials	-	55	-	6.5	Visual	Aids	1.	Click
the	right	mouse	button	while	in	the	3D	Orbit	command.	2.	Choose	Visual	Aids	from	the	pop-up	menu.	3.	Choose	Compass,	Grid,	or	UCS	Icon.	Compass	Grid	UCS	Icon	56.	AutoCAD	3D	Tutorials	-	56	-	6.6	Preset	Views	Sets	the	3D	view	while	in	the	orbit	command	1.	Click	the	right	mouse	button	while	in	the	3D	Orbit	command.	2.	Choose	Preset	Views
from	the	pop-up	menu.	3.	Choose	one	of	the	following	standard	3D	views.	57.	AutoCAD	3D	Tutorials	-	57	-	6.7	Free	Orbit	1.	Choose	View,	Orbit,	Free	Orbit.	The	3D	Orbit	Arcball	appears.	2.	Click	one	of	the	3D	Orbit	Arcball	locations	to	move	the	display	of	your	object(s).	Inside	the	Arcball	-	Allows	movement	in	any	direction	Outside	the	Arcball	-	Moves
View	about	an	axis	that	extends	through	the	center	(acts	like	twist)	Inside	one	of	the	small	circles	to	the	left/right	-	Rotates	around	the	“Y”	axis	through	the	center.	Inside	one	of	the	small	circles	to	the	top/bottom	-	Rotates	around	the	“X”	axis	through	the	center.	58.	AutoCAD	3D	Tutorials	-	58	-	6.8	Continuous	Orbit	1.	Choose	View,	Orbit,	Continuous
Orbit.	2.	Click	and	drag	to	define	the	direction	and	speed	of	a	continuous	orbit	for	your	object(s).	3.	Press	ESC	on	the	keyboard	to	stop	the	orbit.	59.	AutoCAD	3D	Tutorials	-	59	-	6.9	Other	Navigational	Modes	1.	Click	the	right	mouse	button	while	in	the	3D	Orbit	command.	2.	Choose	Other	Navigational	Modes	from	the	pop-up	menu.	3.	Choose	one	of
the	following	modes.	Adjust	Distance	(4)	Simulates	moving	the	camera	closer	to	the	object	or	farther	away.	Swivel	(5)	Changes	the	cursor	to	an	arched	arrow	and	simulates	the	effect	of	swiveling	the	camera.	Walk	(6)	Changes	the	cursor	to	a	plus	sign	and	enables	you	to	"walk	through"	a	model	at	a	fixed	height	above	the	XY	plane,	by	dynamically
controlling	the	location	and	target	of	the	camera.	Fly	(7)	Changes	the	cursor	to	a	plus	sign	and	enables	you	to	"fly	through"	a	model	without	being	restricted	to	a	fixed	height	above	the	XY	plane.	Zoom	(8)	Changes	the	cursor	to	a	magnifying	glass	with	plus	(+)	and	minus	(-)	sign	and	simulates	moving	the	camera	closer	to	an	object	or	farther	away.
Works	like	the	Adjust	Distance	option.	Pan	(9)	Pans	the	drawing	while	in	the	3D	Oribit.	60.	AutoCAD	3D	Tutorials	-	60	-	AutoCAD	3D	–	Chapter	7	3D	Navigation	61.	AutoCAD	3D	Tutorials	-	61	-	7.1	Creating	a	Camera	Sets	a	camera	and	target	location	to	create	and	save	a	3D	perspective	view	of	objects.	1.	Open	a	drawing	with	3D	objects.	2.	Choose
View,	Create	Camera.	or	3.	Type	CAMERA	at	the	command	prompt.	Command:	CAMERA	Current	camera	settings:	Height=0.0000	Lens	Length=50.0000	mm	Specify	camera	location:	.XY	of	(need	Z):	7	Specify	target	location:	endp	Enter	an	option	[?/Name/LOcation/Height/Target/LEns/Clipping/View/eXit]:	X	Camera	location	using	.XY	filter	and	Z
height	of	7	Camera	target	62.	AutoCAD	3D	Tutorials	-	62	-	7.2	Viewing	a	Camera	Once	a	camera	is	created,	it	becomes	a	named	view	in	the	drawing	and	can	be	viewed	using	the	Named	View	Manager.	You	can	also	view	the	camera	using	the	view	option	when	creating	the	camera.	1.	Choose	View,	3D	Views,	Southwest	Isometric	to	be	sure	you	are	not
in	an	existing	camera	view.	2.	Choose	View,	Named	Views.	3.	Click	the	plus	(+)	sign	beside	Model	Views.	4.	Click	Camera1,	Set	Current,	Apply,	and	OK.	View	from	Camera	63.	AutoCAD	3D	Tutorials	-	63	-	7.3	Camera	Preview	Camera	preview	is	a	quick	and	easy	way	to	see	the	properties	of	a	camera	before	viewing	from	the	camera.	1.	Choose	View,	3D
Views,	Southwest	Isometric	to	be	sure	you	are	not	in	an	existing	camera	view.	2.	Zoom	out	until	you	see	the	camera	in	your	3D	view.	3.	Click	once	on	a	camera	in	your	view.	The	Camera	Preview	dialog	box	will	show	the	view	from	the	chosen	camera.	You	can	change	the	Visual	style	of	this	preview	by	clicking	the	Visual	Style	dropdown.	64.	AutoCAD
3D	Tutorials	-	64	-	7.4	Camera	Properties	1.	Double	click	a	camera	in	a	3D	isometric	view,	2.	Choose	one	of	the	following	properties	to	change.	65.	AutoCAD	3D	Tutorials	-	65	-	7.5	Displaying	and	Plotting	a	Camera	Displaying	a	Camera	1.	Choose	View,	Display,	Cameras.	Plotting	a	Camera	1.	Click	View,	Display,	Cameras.	2.	Double-click	a	camera.	3.
Click	Yes	under	the	Plot	option.	66.	AutoCAD	3D	Tutorials	-	66	-	7.6	Adjusting	Camera	Distances	and	Swiveling	a	Camera	Adjust	Camera	Distance	1.	Choose	View,	Named	Views.	2.	Click	the	plus	(+)	sign	beside	Model	Views.	3.	Click	Camera1,	Set	Current,	Apply,	and	OK.	4.	Choose	View,Camera,	Adjust	Distance.	5.	Click	and	drag	to	zoom	in	or	out
about	the	camera,	Swivel	a	Camera	1.	Choose	View,	Camera,	Swivel.	2.	Click	and	drag	to	swivel	the	camera,	67.	AutoCAD	3D	Tutorials	-	67	-	7.7	DView	Command	Defines	parallel	projection	or	perspective	views	by	using	a	camera	and	target.	1.	Choose	View,	3D	Views,	SW	Isometric.	2.	Type	DVIEW	at	the	command	prompt.	Command:	DVIEW	Select
objects	or	:	pick	objects	and	press	ENTER	Enter	option	[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/C	Lip/Hide/Off/Undo]:	PO	Specify	target	point	:	pick	target	(see	below)	Specify	camera	point	:	.XY	of	(need	Z):	7	Enter	option	[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/C	Lip/Hide/Off/Undo]:	D	Specify	new	camera-target	distance	:	click
and	drag	new	zoom	Enter	option	[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/	CLip/Hide/Off/Undo]:	Regenerating	model.	Camera	location	using	.XY	filter	and	Z	height	of	7	Camera	target	68.	AutoCAD	3D	Tutorials	-	68	-	New	perspective	view	69.	AutoCAD	3D	Tutorials	-	69	-	7.8	Walk	and	Fly	You	can	simulate	walking	and	flying	through	a	3D
drawing.	When	you	walk	through	a	model,	you	travel	along	the	XY	plane.	When	you	fly	through	a	model,	you	are	not	constrained	by	the	XY	plane,	so	you	appear	to	“fly”	over	an	area	in	a	model.	The	following	shortcuts	are	available	for	walking:	Up	arrow	/	W	key	Move	forward	Down	arrow	/	S	key	Move	backward	Left	arrow	/	A	key	Move	left	Right
arrow	/	D	key	Move	right	Drag	mouse	Look	around	&	turn	1.	Open	a	drawing	with	3D	objects	and	display	in	a	3D	view.	2.	Create	a	camera	anywhere	in	the	drawing	and	set	the	view	to	that	camera.	3.	Choose	View,	Walk	and	Fly,	and	Walk.	or	4.	Type	3DWalk	or	3DFky	at	the	command	prompt.	Command:	3DWALK	The	following	Position	Locator	dialog
box	will	appear	that	you	can	use	to	navigate	your	drawing.	70.	AutoCAD	3D	Tutorials	-	70	-	5.	Press	the	Up,	Down,	Left,	and	Right	keys	on	the	keyboard	to	see	how	the	camera	location	moves	in	the	drawing	and	Position	Locator	dialog	box.	6.	Move	the	camera	and	target	in	the	Position	Locator	dialog	box.	7.	Click	and	drag	your	mouse	to	“fly”	through
the	drawing.	8.	Close	the	Position	Locator	dialog	box	and	try	walking	and	flying	using	only	the	keys	on	the	keyboard	and	mouse.	71.	AutoCAD	3D	Tutorials	-	71	-	7.9	Walk	and	Fly	Settings	1.	Choose	View,	Walk	and	Hide,	Walk	and	Hide	Settings.	or	2.	Type	WALKFLYSETTINGS	at	the	command	prompt.	Command:	WALKFLYSETTINGS	3.	Choose	one	of
the	following	settings	from	the	Walk	and	Fly	dialog	box.	If	you	are	working	in	a	drawing	with	a	large	architectural	scale,	be	sure	to	set	your	drawing	units	to	a	large	number,	similar	to	the	scale	of	the	drawing.	72.	AutoCAD	3D	Tutorials	-	72	-	7.10	Animation	Paths	1.	Open	a	drawing	with	3D	objects	and	display	in	a	3D	view.	2.	Draw	a	line	or	polyline
representing	a	path	for	an	animation	3.	Choose	View,	Motion	Path	Animations.	or	4.	Type	ANIPATH	at	the	command	prompt.	Command:	ANIPATH	5.	Select	Path	under	the	Link	camera	to:	option	6.	Click	the	line	or	polyline	path.	7.	Type	Path1	as	the	default	path	name.	8.	Select	Path	under	the	Link	target	to:	option	9.	Click	on	the	line	or	polyline	path.
10.	Type	Path2	as	the	default	path	name.	11.	Change	other	animation	settings	such	as	the	frames	per	second,	duration,	resolution,	etc.	73.	AutoCAD	3D	Tutorials	-	73	-	12.	Choose	the	Preview…button	to	preview	your	animation.	13.	Close	the	animation	preview	and	click	OK	to	create	an	animation	file.	14.	Play	your	animation	in	a	PC	or	MacIntosh
video	review	application	such	as	Media	Player	or	Quicktime.	74.	AutoCAD	3D	Tutorials	-	74	-	AutoCAD	3D	–	Chapter	8	3D	Model	Objects	75.	AutoCAD	3D	Tutorials	-	75	-	8.1	Wireframes	A	wireframe	model	is	a	skeletal	description	of	a	3D	object.	There	are	no	surfaces	in	a	wireframe	model;	it	consists	only	of	points,	lines,	and	curves	that	describe	the
edges	of	the	object.	With	AutoCAD	you	can	create	wireframe	models	by	positioning	2D	objects	anywhere	in	3D	space.	AutoCAD	also	provides	some	3D	wireframe	objects,	such	as	3D	polylines	(that	can	only	have	a	CONTINUOUS	linetype)	and	splines.	Because	each	object	that	makes	up	a	wireframe	model	must	be	independently	drawn	and	positioned,
this	type	of	modeling	can	be	the	most	time-consuming.	Wireframe	lines	in	3D	76.	AutoCAD	3D	Tutorials	-	76	-	8.2	Surfaces	Surface	modeling	is	more	sophisticated	than	wireframe	modeling	in	that	it	defines	not	only	the	edges	of	a	3D	object,	but	also	its	surfaces.	The	AutoCAD	surface	modeler	defines	faceted	surfaces	using	a	polygonal	mesh.	Because
the	faces	of	the	mesh	are	planar,	the	mesh	can	only	approximate	curved	surfaces.	77.	AutoCAD	3D	Tutorials	-	77	-	8.3	Solids	Solid	modeling	is	the	easiest	type	of	3D	modeling	to	use.	With	the	AutoCAD	solid	modeler,	you	can	make	3D	objects	by	creating	basic	3D	shapes:	boxes,	cones,	cylinders,	spheres,	wedges,	and	tori	(do-	nuts).	You	can	then
combine	these	shapes	to	create	more	complex	solids	by	joining	or	subtracting	them	or	finding	their	intersecting	(over-	lapping)	volume.	You	can	also	create	solids	by	sweeping	a	2D	object	along	a	path	or	revolving	it	about	an	axis.	78.	AutoCAD	3D	Tutorials	-	78	-	AutoCAD	3D	–	Chapter	9	2D	Solids	and	3D	Faces	79.	AutoCAD	3D	Tutorials	-	79	-	9.1	2D
Solid	Creates	solid-filled	triangles	and	quadrilaterals.	1.	Type	SOLID	at	the	command	prompt.	Command:	SOLID	First	point:	P1	Second	point:	P2	Third	point:	P3	Fourth	point:	P4	Third	point:	enter	80.	AutoCAD	3D	Tutorials	-	80	-	9.2	3D	Faces	3DFACE	creates	a	three	or	four	sided	surface	anywhere	in	3D	space.	You	can	specify	different	Z	coordinates
for	each	corner	point	of	a	3D	face.	3DFACE	differs	from	SOLID,	which	creates	a	three-	or	four-sided	surface	that	is	parallel	to	the	current	UCS	and	can	be	extruded.	1.	Begin	a	new	drawing.	2.	Set	the	visual	style	to	Conceptual.	3.	Type	3DFACE	at	the	command	prompt.	Command:	3DFACE	First	point:	pick	Second	point:	pick	Third	point:	pick	Fourth
point:	pick	Third	point:	enter	3D	Wireframe	Lines	3D	Face	81.	AutoCAD	3D	Tutorials	-	81	-	9.3	3D	Face	Invisible	Edge	With	3DFACE,	you	control	which	edges	of	a	3D	face	are	visible,	allowing	accurate	modeling	of	objects	with	holes.	Entering	i	or	invisible	before	the	first	point	of	an	edge	makes	the	edge	invisible.Type	3DFACE	at	the	command	prompt.
1.	Draw	an	irregular	shaped	object	similar	to	the	one	shown	below.	2.	Set	the	visual	style	to	Conceptual.	3.	Type	3DFACE	at	the	command	prompt.	Command:	3DFACE	First	point:	P1	Second	point:	P2	Third	point:	i	P3	Fourth	point:	P4	Third	point:	i	P5	Fourth	point:	P6	Third	point:	P7	Fourth	point:	P8	Third	point:	enter	NOTE:	You	must	enter	an	“i”	for
invisible	before	the	face	is	chosen.	82.	AutoCAD	3D	Tutorials	-	82	-	9.4	Edge	Command	1.	Type	EDGE	at	the	command	prompt.	Command:	EDGE	Specify	edge	of	3dface	to	toggle	visibility	or	[Display]:	pick	edge	Specify	edge	of	3dface	to	toggle	visibility	or	[Display]:	D	Enter	selection	method	for	display	of	hidden	edges	[Select/All]	:	A	**	Regenerating
3DFACE	objects...done.	Specify	edge	of	3dface	to	toggle	visibility	or	[Display]:	press	enter	Pick	edge	83.	AutoCAD	3D	Tutorials	-	83	-	9.5	PFace	Creates	a	three-dimensional	polyface	mesh	vertex	by	vertex	1.	Type	PFACE	at	the	command	prompt.	Command:	PFACE	Specify	location	for	vertex	1:	pick	point	1	Specify	location	for	vertex	2	or	:	pick	point	2
Specify	location	for	vertex	3	or	:	pick	point	3	Specify	location	for	vertex	4	or	:	pick	point	4	Specify	location	for	vertex	5	or	:	pick	point	5	Specify	location	for	vertex	6	or	:	pick	point	6	Specify	location	for	vertex	7	or	:	pick	point	7	Specify	location	for	vertex	8	or	:	enter	Face	1,	vertex	1:	Enter	a	vertex	number	or	[Color/Layer]:	1	(enter)	Face	1,	vertex	2:
Enter	a	vertex	number	or	[Color/Layer]	:	2	(enter)	Face	1,	vertex	3:	Enter	a	vertex	number	or	[Color/Layer]	:	6	(enter)	Face	1,	vertex	4:	Enter	a	vertex	number	or	[Color/Layer]	:	7	(enter)	Face	1,	vertex	5:	enter	Enter	a	vertex	number	or	[Color/Layer]	:	Face	2,	vertex	1:	Enter	a	vertex	number	or	[Color/Layer]:	2	(enter)	Face	2,	vertex	2:	Enter	a	vertex
number	or	[Color/Layer]	:	3	(enter)	Face	2,	vertex	3:	Enter	a	vertex	number	or	[Color/Layer]	:	4	(enter)	Face	2,	vertex	4:	84.	AutoCAD	3D	Tutorials	-	84	-	Enter	a	vertex	number	or	[Color/Layer]	:	6	(enter)	Face	2,	vertex	5:	Enter	a	vertex	number	or	[Color/Layer]	:	Face	3,	vertex	1:	Enter	a	vertex	number	or	[Color/Layer]:	4	(enter)	Face	3,	vertex	2:	Enter
a	vertex	number	or	[Color/Layer]	:	5	(enter)	Face	3,	vertex	3:	Enter	a	vertex	number	or	[Color/Layer]	:	6	(enter)	Face	3,	vertex	4:	Enter	a	vertex	number	or	[Color/Layer]	:	Face	4,	vertex	1:	enter	Enter	a	vertex	number	or	[Color/Layer]:	85.	AutoCAD	3D	Tutorials	-	85	-	AutoCAD	3D	–	Chapter	10	Basic	3D	Surfaces	86.	AutoCAD	3D	Tutorials	-	86	-	10.1
Basic	Mesh	Commands	1.	Click	the	3D	Modeling	dropdown	option	from	the	Solids	panel.	2.	Click	the	Mesh	tab.	3.	Click	the	Primitives	panel.	4.	Click	the	Primitive	drop-down.	Mesh	Primitive	Options	The	following	settings	can	be	adjusted	for	mesh	primitives.	87.	AutoCAD	3D	Tutorials	-	87	-	Mesh	Box	1.	Choose	Mesh	box	from	the	Primitives	panel.
Command:	MESH	Current	smoothness	level	is	set	to	:	0	Enter	an	option	[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/	SEttings]	:	_BOX	Specify	first	corner	or	[Center]:	pick	point	Specify	other	corner	or	[Cube/Length]:	@4,2	Specify	height	or	[2Point]	:	2	88.	AutoCAD	3D	Tutorials	-	88	-	Mesh	Cone	1.	Choose	Mesh	cone	from	the	Primitives	panel.
Command:	MESH	Current	smoothness	level	is	set	to	:	0	Enter	an	option	[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/S	Ettings]	:	CONE	Specify	center	point	of	base	or	[3P/2P/Ttr/Elliptical]:	Specify	base	radius	or	[Diameter]	:	2	Specify	height	or	[2Point/Axis	endpoint/Top	radius]	:	5	89.	AutoCAD	3D	Tutorials	-	89	-	Mesh	Cylinder	1.	Choose	Mesh
cylinder	from	the	Primitives	panel.	Command:	MESH	Current	smoothness	level	is	set	to	:	0	Enter	an	option	[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/	SEttings]	:	CYLINDER	Specify	center	point	of	base	or	[3P/2P/Ttr/Elliptical]:	Specify	base	radius	or	[Diameter]	:	2	Specify	height	or	[2Point/Axis	endpoint]	:	8	90.	AutoCAD	3D	Tutorials	-	90	-
Mesh	Pyramid	1.	Choose	Mesh	pyramid	from	the	Primitives	panel.	Command:	MESH	Current	smoothness	level	is	set	to	:	0	Enter	an	option	[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/S	Ettings]	:	PYRAMID	4	sides	Circumscribed	Specify	center	point	of	base	or	[Edge/Sides]:	Specify	base	radius	or	[Inscribed]	:	Specify	height	or	[2Point/Axis
endpoint/Top	radius]	:	4	91.	AutoCAD	3D	Tutorials	-	91	-	Mesh	Sphere	1.	Choose	Mesh	sphere	from	the	Primitives	panel.	Command:	MESH	Current	smoothness	level	is	set	to	:	0	Enter	an	option	[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/S	Ettings]	:	SPHERE	Specify	center	point	or	[3P/2P/Ttr]:	Specify	radius	or	[Diameter]	:	92.	AutoCAD	3D
Tutorials	-	92	-	Mesh	Wedge	1.	Choose	Mesh	wedge	from	the	Primitives	panel.	Command:	MESH	Current	smoothness	level	is	set	to	:	0	Enter	an	option	[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/S	Ettings]	:	WEDGE	Specify	first	corner	or	[Center]:	Specify	other	corner	or	[Cube/Length]:	@4,2	Specify	height	or	[2Point]	:	2	93.	AutoCAD	3D
Tutorials	-	93	-	Mesh	Torus	1.	Choose	Mesh	torus	from	the	Primitives	panel.	Command:	MESH	Current	smoothness	level	is	set	to	:	0	Enter	an	option	[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/S	Ettings]	:	TORUS	Specify	center	point	or	[3P/2P/Ttr]:	Specify	radius	or	[Diameter]	:	6	Specify	tube	radius	or	[2Point/Diameter]:	1	94.	AutoCAD	3D
Tutorials	-	94	-	10.2	Mesh	Tesselations	By	default,	new	mesh	primitives	are	created	with	no	smoothness.	To	change	the	default	smoothness,	enter	mesh	at	the	Command	prompt.	Specify	the	Settings	option	before	you	specify	the	type	of	mesh	primitive	you	want	to	create.	1.	Type	MESH	at	the	command	prompt.	Command:	MESH	Enter	an	option
[Box/Cone/CYlinder/Pyramid/Sphere/Wedge	/Torus/SEttings]	:	SE	Specify	level	of	smoothness	or	[Tessellation]	:	3	Enter	an	option	[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/	Torus/SEttings]	:	BOX	Specify	first	corner	or	[Center]:	pick	point	Specify	other	corner	or	[Cube/Length]:	@5,5	Specify	height	or	[2Point]	:	95.	AutoCAD	3D	Tutorials	-	95	-	10.3
Mesh	Smooth	Converts	3D	faces	(3DFACE)	and	legacy	polygonal	and	polyface	meshes	(from	AutoCAD	2009	and	earlier).	You	can	also	convert	2D	objects	such	as	regions	and	closed	polylines.	The	default	mesh	settings	are	defined	in	the	Mesh	Tessellation	Options	dialog	box.	The	level	of	smoothness	upon	conversion	depends	on	the	mesh	type	setting	in
this	dialog	box.	If	the	mesh	type	is	not	set	to	be	optimized,	the	converted	object	is	not	smoothed	1.	Type	MESHSMOOTH	at	the	command	prompt.	Command:	MESHSMOOTH	Select	objects	to	convert:	pick	object	Select	objects	to	convert:	press	enter	2.	Click	Create	mesh.	2D	Polyline	before	MESHSMOOTH	2D	Polyline	after	MESHSMOOTH	96.
AutoCAD	3D	Tutorials	-	96	-	10.4	Smooth	and	Refine	Meshes	The	following	commands	control	the	smoothness	of	mesh	objects.	Meshsmoothmore	Increases	the	level	of	smoothness	for	mesh	objects	by	one	level.	1.	Type	MESHSMOOTHMORE	at	the	command	prompt.	Command:	MESHSMOOTHMORE	Select	mesh	objects	to	increase	the	smoothness
level:	pick	object.	Mesh	before	smooth	increase	Mesh	after	smooth	increase	97.	AutoCAD	3D	Tutorials	-	97	-	Meshsmoothless	Decreases	the	level	of	smoothness	for	mesh	objects	by	one	level.	1.	Type	MESHSMOOTHLESS	at	the	command	prompt.	Command:	MESHSMOOTHLESS	Select	mesh	objects	to	increase	the	smoothness	level:	pick	object.	Mesh
before	smooth	decrease	Mesh	after	smooth	decrease	98.	AutoCAD	3D	Tutorials	-	98	-	Meshsmoothrefine	Multiplies	the	number	of	faces	in	selected	mesh	objects	or	faces.	.	1.	Type	MESHREFINE	at	the	command	prompt.	Command:	'_MESHREFINE	Select	mesh	object	or	face	subobjects	to	refine:	pick	object	Select	mesh	object	or	face	subobjects	to
refine:	1	object(s)	found.	Mesh	refine	before	Mesh	refine	after	99.	AutoCAD	3D	Tutorials	-	99	-	10.5	Add	and	Remove	Mesh	Creases	Meshcrease	Sharpens	the	edges	of	selected	mesh	subobjects.	1.	Type	MESHCREASE	at	the	command	prompt.	Command:	MESHCREASE	Select	mesh	subobjects	to	crease:	select	objects	Specify	crease	value	[Always]	:
enter	Before	crease	Selected	objects	After	crease	TIPS:	Crease	value	Sets	highest	smoothing	level	at	which	the	crease	is	retained.	If	the	smoothing	level	exceeds	this	value,	the	crease	is	also	smoothed.	Enter	a	value	of	0	to	remove	an	existing	crease.	Always	Specifies	that	the	crease	is	always	retained,	even	if	the	object	or	subobject	is	smoothed	or
refined.	A	crease	value	of	-1	is	the	same	as	Always.	100.	AutoCAD	3D	Tutorials	-	100	-	Meshuncrease	Removes	the	crease	from	selected	mesh	faces,	edges,	or	vertices.	.	1.	Type	MESHUNCREASE	at	the	command	prompt.	Command:	MESHUNCREASE	Select	crease	to	remove:	pick	object	Select	crease	to	remove:	press	enter	Before	uncrease	Selected
objects	After	uncrease	101.	AutoCAD	3D	Tutorials	-	101	-	10.6	Editing	Meshes	Meshextrude	Extends	a	mesh	face	into	3D	space.	1.	Type	MESHEXTRUDE	at	the	command	prompt.	Command:	_MESHEXTRUDE	Adjacent	extruded	faces	set	to:	Join	Select	mesh	face(s)	to	extrude	or	[Setting]:	pick	object(s)	Select	mesh	face(s)	to	extrude	or	[Setting]:
Specify	height	of	extrusion	or	[Direction/Path/	Taper	angle]	:	1	Selected	mesh	face	Extruded	mesh	face	102.	AutoCAD	3D	Tutorials	-	102	-	Meshsplit	Splits	a	mesh	face	into	2	faces.	1.	Type	MESHSPLIT	at	the	command	prompt.	Command:	_MESHSPLIT	Select	a	mesh	face	to	split:	(pick	object)	Specify	first	split	point	on	face	edge	or	[Vertex]:MID	of
Specify	second	split	point	on	face	edge	or	[Vertex]:	MID	of	MIDpoint	MIDpoint	103.	AutoCAD	3D	Tutorials	-	103	-	Mergeface	Merges	adjacent	faces	into	a	single	face.	1.	Type	MESHMERGE	at	the	command	prompt.	Command:	_MESHMERGE	Select	adjacent	mesh	faces	to	merge:	(pick	object)	Select	adjacent	mesh	faces	to	merge:	(pick	object)	Select
adjacent	mesh	faces	to	merge:	press	enter	Selected	mesh	faces	Resultant	merge	104.	AutoCAD	3D	Tutorials	-	104	-	Meshcap	(Close	Hole)	Creates	a	mesh	face	that	connects	open	edges..	1.	Type	MESHCAP	at	the	command	prompt.	Command:	_MESHCAP	Select	connecting	mesh	edges	to	create	a	new	mesh	face:	(pick	objects)	Select	connecting	mesh
edges	to	create	a	new	mesh	face:	press	enter	Mesh	object	before	Selected	mesh	edges	Closed	“hole”	105.	AutoCAD	3D	Tutorials	-	105	-	Converting	Meshes	Converts	objects	to	surfaces.	Objects	that	can	be	converted	to	surfaces	include	the	following:	2D	solids,	3D	solids,	Regions,	open,	zero-width	polylines	with	thickness,	lines	with	thickness,	arcs
with	thickness,	mesh	objects,	planar	3D	faces	1.	Type	CONVTOSURFACE	at	the	command	prompt.	Command:	CONVTOSURFACE	Mesh	conversion	set	to:	Smooth	and	optimized.	Select	objects:	pick	object	Select	objects:	press	enter	PLine	with	thickness	New	converted	mesh	Smooth	options	106.	AutoCAD	3D	Tutorials	-	106	-	AutoCAD	3D	–	Chapter	11
Complex	Surfaces	107.	AutoCAD	3D	Tutorials	-	107	-	11.1	Revolved	Surfaces	Regenerates	a	three-dimensional	model	with	hidden	lines	1.	Type	REVSURF	at	the	command	prompt.	Command:	REVSURF	Current	wire	frame	density:	SURFTAB1=6	SURFTAB2=6	Select	object	to	revolve:	pick	path	curve	Select	object	that	defines	the	axis	of	revolution:
pick	line	Specify	start	angle	:	enter	Specify	included	angle	(+=ccw,	-=cw)	:	enter	108.	AutoCAD	3D	Tutorials	-	108	-	11.2	Surftab	Variables	Sets	the	number	of	tabulations	for	both	directions	to	be	generated	for	RULESURF	and	TABSURF.	Also	sets	the	mesh	density	in	ROTATE3D	the	M	direction	for	REVSURF	and	EDGESURF	commands.	1.	Type
Surftab1	at	the	command	prompt.	Command:	SURFTAB1	Enter	new	value	for	SURFTAB1	:	30	2.	Type	Surftab2	at	the	command	prompt.	Command:	SURFTAB2	Enter	new	value	for	SURFTAB2	:	30	3.	Type	Revsurf	at	the	command	prompt.	Command:	REVSURF	Current	wire	frame	density:	SURFTAB1=30	SURFTAB2=30	Select	object	to	revolve:	pick
path	curve	Select	object	that	defines	the	axis	of	revolution:	pick	line	Specify	start	angle	:	enter	Specify	included	angle	(+=ccw,	-=cw)	:	press	enter	109.	AutoCAD	3D	Tutorials	-	109	-	11.3	Tabulated	Surfaces	1.	Type	TABSURF	at	the	command	prompt.	Command:	TABSURF	Select	object	for	path	curve:	Select	object	for	direction	vector:	110.	AutoCAD
3D	Tutorials	-	110	-	11.4	Ruled	Surfaces	1.	Type	RULESURF	at	the	command	prompt.	Command:	rulesurf	Current	wire	frame	density:	SURFTAB1=6	Select	first	defining	curve:	P1	Select	second	defining	curve:	P2	111.	AutoCAD	3D	Tutorials	-	111	-	11.5	Edge	Surfaces	Regenerates	a	three-dimensional	model	with	hidden	lines	1.	Type	EDGESURF	at	the
command	prompt.	Command:	EDGESURF	Current	wire	frame	density:	SURFTAB1=20	SURFTAB2=10	Select	object	1	for	surface	edge:	P1	Select	object	2	for	surface	edge:	P2	Select	object	3	for	surface	edge:	P3	Select	object	4	for	surface	edge:	P4	112.	AutoCAD	3D	Tutorials	-	112	-	11.6	Planesurf	Creates	a	planar	surface	by	selecting	a	closed	object
or	by	creating	a	rectangular	plane.	1.	Type	PLANESURF	at	the	command	prompt.	Command:	PLANESURF	Specify	first	corner	or	[Object]	:	press	enter	Select	objects:	pick	object	Select	objects:	press	enter	Planar	surface	113.	AutoCAD	3D	Tutorials	-	113	-	11.7	Extrude	Surfaces	Creates	a	3D	solid	or	surface	by	extending	the	dimensions	of	an	object.	1.
Type	EXTRUDE	at	the	command	prompt.	Command:	EXTRUDE	Current	wire	frame	density:	ISOLINES=4,	Closed	profiles	creation	mode	=	Surface	Select	objects	to	extrude	or	[MOde]:	pick	object	creation	mode	[SOlid/SUrface]	:	_su	Select	objects	to	extrude	or	[MOde]:enter	Specify	height	of	extrusion	or	[Direction/Path/Taper	angle/Expression]	:	10
114.	AutoCAD	3D	Tutorials	-	114	-	11.8	Loft	Command	Creates	a	3D	solid	or	surface	in	the	space	between	several	cross	sections..	1.	Type	LOFT	at	the	command	prompt.	Command:	LOFT	Current	wire	frame	density:	ISOLINES=4,	Closed	profiles	creation	mode	=	Surface	Select	cross	sections	in	lofting	order	or	[POint/Join	multiple	edges/MOde]:	select
object	Select	cross	sections	in	lofting	order	or	[POint/Join	multiple	edges/MOde]:	select	object	Select	cross	sections	in	lofting	order	or	[POint/Join	multiple	edges/MOde]:	select	o	bject	Select	cross	sections	in	lofting	order	or	[POint/Join	multiple	edges/MOde]:	3	cross	sections	selected	Enter	an	option	[Guides/Path/Cross	sections	only/Settings]	:	press
enter	Objects	before	Surfaces	using	loft	115.	AutoCAD	3D	Tutorials	-	115	-	11.9	Sweep	Command	Creates	a	3D	surface	by	sweeping	a	2D	or	3D	curve	along	a	path.	1.	Type	SWEEP	at	the	command	prompt.	Command:	SWEEP	Current	wire	frame	density:	ISOLINES=4,	Closed	profiles	creation	mode	=	Surface	Select	objects	to	sweep	or	[MOde]:	select
object	Select	objects	to	sweep	or	[MOde]:	select	path	(line)	Select	sweep	path	or	[Alignment/Base	point/Scale/Twist]:	116.	AutoCAD	3D	Tutorials	-	116	-	11.10	Surface	Network	One	way	to	create	surfaces	is	with	a	network	of	curves.	The	SURFNETWORK	command	creates	a	surface	similar	to	a	lofted	surface	from	a	network	of	curves	in	the	U	and	V
directions.	A	network	surface	also	can	be	created	from	curves	that	are	not	all	connected.	The	resulting	surface	can	be	either	a	procedural	surface	or	a	NURBS	surface.	1.	Type	SURFNETWORK	at	the	command	prompt.	Command:	SURFNETWORK	117.	AutoCAD	3D	Tutorials	-	117	-	11.11	Revolve	Surface	One	way	to	create	surfaces	is	with	a	network
of	curves.	The	SURFNETWORK	command	creates	a	surface	similar	to	a	lofted	surface	from	a	network	of	curves	in	the	U	and	V	directions.	A	network	surface	also	can	be	created	from	curves	that	are	not	all	connected.	The	resulting	surface	can	be	either	a	procedural	surface	or	a	NURBS	surface.	1.	Type	REVOLVE	at	the	command	prompt.	Command:
REVOLVE	Current	wire	frame	density:	ISOLINES=4,	Closed	profiles	creation	mode	=	Surface	Select	objects	to	revolve	or	[MOde]:	select	object	Select	objects	to	revolve	or	[MOde]:	press	enter	Specify	axis	start	point	or	define	axis	by	[Object/X/Y/Z]	:	select	endpoints	of	sxis	Specify	axis	endpoint:	Specify	angle	of	revolution	or	[STart
angle/Reverse/EXpression]	:	press	enter	118.	AutoCAD	3D	Tutorials	-	118	-	11.12	Surface	Blend	Creates	a	blend	surface	between	two	existing	surfaces.	1.	Type	SURFBLEND	at	the	command	prompt.	Command:	SURFBLEND	119.	AutoCAD	3D	Tutorials	-	119	-	11.13	Surface	Patch	Creates	a	new	surface	or	cap	to	close	an	open	edge	of	an	existing
surface.	1.	Type	SURFPATCH	at	the	command	prompt.	Command:	SURFPATCH	120.	AutoCAD	3D	Tutorials	-	120	-	11.14	Offsetting	Surfaces	Creates	a	parallel	surface	at	a	specified	distance	from	the	original	surface.	1.	Type	SURFOFFSET	at	the	command	prompt.	Command:	SURFOFFSET	121.	AutoCAD	3D	Tutorials	-	121	-	11.15	Editing	Surfaces
Surface	Fillet	1.	Type	SURFFILLET	at	the	command	prompt.	Command:	SURFFILLET	Surface	Trim	1.	Type	SURFTRIM	at	the	command	prompt.	Command:	SURFTRIM	122.	AutoCAD	3D	Tutorials	-	122	-	Surface	UnTrim	1.	Type	SURFUNTRIM	at	the	command	prompt.	Command:	SURFUNTRIM	Surface	Extend	1.	Type	SURFEXTEND	at	the	command
prompt.	Command:	SURFEXTEND	Surface	Suplt	1.	Type	SURFSCULPT	at	the	command	prompt.	Command:	SURFSCULPT	123.	AutoCAD	3D	Tutorials	-	123	-	Surface	CV	Edit	Bar	Adds	and	edits	control	vertices	on	a	NURBS	surface	or	spline	1.	Type	SURFSCULPT	at	the	command	prompt.	Command:	SURFSCULPT	Convert	to	NURBS	1.	Type
CONVTONURBS	at	the	command	prompt.	Command:	CONVTONURBS	124.	AutoCAD	3D	Tutorials	-	124	-	11.16	NURB	Vertex	Controls	Surface	CV	-	Show	Shows	NURB	vertices.	1.	Type	CVSHOW	at	the	command	prompt.	Command:	CVSHOW	Surface	CV	-	Hide	Hides	NURB	vertices.	1.	Type	CVHIDE	at	the	command	prompt.	Command:	CVHIDE	125.
AutoCAD	3D	Tutorials	-	125	-	Surface	CV	Rebuild	Rebuilds	control	vertices	of	NURBS	surfaces	or	spline	1.	Type	CVREBUILD	at	the	command	prompt.	Command:	CVREBUILD	Surface	CV	Add	Adds	control	vertices	of	NURBS	surfaces	or	spline	1.	Type	CVADD	at	the	command	prompt.	Command:	CVADD	126.	AutoCAD	3D	Tutorials	-	126	-	Surface
Remove	Removes	control	vertices	of	NURBS	surfaces	or	spline	1.	Type	CVREMOVE	at	the	command	prompt.	Command:	CVREMOVE	127.	AutoCAD	3D	Tutorials	-	127	-	11.17	Surface	Analysis	Analysis	Zebra	Projects	parallel	lines	onto	a	model	to	help	you	analyze	surface	continuity.	The	way	the	stripes	line	up	where	two	surfaces	meet	helps	analyze
the	tangency	and	curvature	of	the	intersection.	1.	Type	ANALYSISZEBRA	at	the	command	prompt.	Command:	ANALYSISZEBRA	Analysis	Curvature	Displays	a	color	gradient	onto	a	surface	so	you	can	evaluate	the	high	and	low	areas	of	curvature..	1.	Type	ANALYSISCURVATURE	at	the	command	prompt.	Command:	ANALYSISCURVATURE	128.
AutoCAD	3D	Tutorials	-	128	-	Analysis	Draft	Displays	a	color	gradient	onto	a	surface	so	you	can	evaluate	if	a	model	has	adequate	draft	between	a	part	and	its	mold	1.	Type	ANALYSISDRAFT	at	the	command	prompt.	Command:	ANALYSISDRAFT	129.	AutoCAD	3D	Tutorials	-	129	-	11.18	Work	with	Associative	Surfaces	and	Constraints
SURFACEASSOCIATIVITY	Like	hatch	and	dimensions,	surfaces	can	also	be	associative.	When	a	surface	is	moved	or	modified,	any	associated	surface	is	adjusted	automatically.	In	this	illustration,	the	boat	is	made	up	of	four	surfaces.	When	one	of	the	sides	is	stretched	and	reshaped,	all	associated	surfaces	adjust	accordingly.	Use	the
SURFACEASSOCIATIVITY	system	variable	to	turn	associativity	on	and	off.	Associativity	also	allows	you	to	apply	mathematical	expressions	and	parametric	constraints	to	surfaces.	Mathematical	expressions	can	be	applied	to	surface	properties	such	as	radius	and	height.	For	example,	you	can	specify	that	the	height	of	a	surface	is	always	one	half	of	the
length	of	a	solid	box.	Parametric	constraints	restrict	the	relative	position	of	one	object	to	another.	In	this	example,	the	arc	that	was	extruded	to	create	the	surface	is	locked	in	a	fixed	position.	When	you	edit	the	associated	surface,	the	arc	surface	stays	in	place.	130.	AutoCAD	3D	Tutorials	-	130	-	AutoCAD	3D	–	Chapter	12	Creating	Solids	131.	AutoCAD
3D	Tutorials	-	131	-	12.1	Solid	Primitives	Solid	primitives	can	easily	be	drawn	from	from	the	3D	Modeling	panel,	Solid	Panel	.	132.	AutoCAD	3D	Tutorials	-	132	-	12.2	Polysolid	Command	With	the	POLYSOLID	command,	you	can	convert	an	existing	line,	2D	polyline,	arc,	or	circle	to	a	solid	with	a	rectangular	profile.	A	polysolid	can	have	curved
segments,	but	the	profile	is	always	rectangular	by	default.	1.	Open	a	drawing	with	a	closed	2D	polyline	and	display	in	a	3D	view.	2.	Type	POLYSOLID	at	the	command	prompt.	Command:	polysolid	Specify	start	point	or	[Object/Height/Width/Justify]	:	h	Specify	height
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